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Trilithic Company Profile

Trilithic is a privately held manufacturer founded in 1986 as an engineering and assembly
company that built and designed customer-directed products for telecommunications, military, and
industrial customers.  From its modest beginnings as a two-man engineering team, Trilithic grew
over the years and broadened its offerings of RF and microwave components by adding
broadband solutions to its product line.  This was accomplished with the acquisition of
components manufacturer Cir-Q-Tel and instruments manufacturer Texscan.

Today, Trilithic is an industry leader providing telecommunications solutions for major broadband,
RF, and microwave markets around the world.  As an ISO 9000:2001 certified company with over
40 years of collective expertise in engineering and custom assembly, Trilithic is dedicated to
providing quality products, services, and communications solutions that exceed customer
expectations.

Trilithic is comprised of five major divisions:

• Broadband Instruments and Systems
Offers test, analysis, and quality management solutions for the major cable television
systems worldwide.

• RF Microwave Components
Provides components and custom subsystems for companies specializing in cellular,
military, and other wireless applications.

• Emergency Alert Systems
Leading supplier of government-mandated emergency alert systems used by broadcast
TV, cable TV, IPTV, DBS, and radio stations.

• XFTP
Offers a specialty line of field technical products for cable operators and technicians, as
well as a line of products for installing electronics in the home of the future.

• Network Services
Provides network data management and support services to safeguard and protect your
network and data by employing certified, experienced, and dedicated network engineers.
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Helpful Website

The following website contains general information which may be of interest to you:

http://www.trilithic.com

Trilithic’s website contains product specifications and information, tips, release information,
marketing information, Frequently Asked Questions (FAQs), bulletins, and other technical
information.  You can also check this website for product updates.

Where to Get Technical Support

Trilithic technical support is available Monday through Friday from 8:00AM to 5:00PM EST.
Callers in North America can dial 1-317-895-3600 or 1-800-344-2412 (toll free).  International
callers should dial 1-317-895-3600 or fax questions to 1-317-895-3613. You can also e-mail
technical support at EASysupport@trilithic.com.

For quicker support response when calling or sending e-mail, please provide the following
information:

• Your name and your company name

• The technical point of contact (name, phone number, e-mail address)

• The Visionary Editor software’s version number

• A detailed description of the problem you are having, including any error or information
messages

1. General Information
Chapter 1
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Conventions Used in this Manual

This manual has several standard conventions for presenting information.

• Connections, menus, menu options, and user entered text and commands appear in bold.

• Section names, web, and e-mail addresses appear in italics.

A NOTE is information that will be of assistance to you related
to the current step or procedure.

A CAUTION alerts you to any condition that could cause a
mechanical failure or potential loss of data.

How this Manual is Organized

This manual is divided into the following chapters:

• Chapter 1, “General Information,” provides Trilithic contact information and describes how
this operation manual is structured.

• Chapter 2, “Introduction,” introduces the Visionary Editor program and discusses its
purpose and capabilities.

• Chapter 3, “Software Installation,” describes the steps necessary to install the Visionary
Editor software and the host computer requirements.

• Chapter 4, “Configuration,” describes the steps necessary to configure the Visionary Editor
program.

• Chapter 5, “Software Operation,” includes a instructions for creating, editing, saving, and
uploading custom video overlay pages.
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2. Introduction
Chapter 2

What is the Visionary Editor Program?

The Visionary Editor program is a software application used to create and upload video overlay
pages to the Visionary SDI Overlay System.  Pages are comprised of static text, crawling text,
boxes, images, and audio.  The Visionary Editor program allows operators to create custom
video overlay pages with graphics and text; save multiple messages for later distribution; then
upload the message to remotely-installed Visionarys.  Delivery of the video overlay pages to the
Visionarys is triggered by the operator.
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3. Installation
Chapter 3

Prerequisites

Minimum Computer System Requirements
Computer equipment required to install the Visionary Editor software:

• 1 GHz processor or faster

• 512 MB memory or greater

• Microsoft® Windows XP® or later operating system

• Network connection

• 50 MB of available hard drive space

Installing the Visionary Editor Software

1. Depending on which operating system you are installing the Visionary Editor software on,
you may need to log in as the system administrator.

2. Insert the Visionary Editor software CD into the appropriate drive.

3. If Autorun is enabled for the CD-ROM drive, the Visionary Editor setup program will start
automatically.  If the setup program does not start, click the Windows Start button, then
select Run and type [drive]:\setup.exe, then click the OK button (substitute the
appropriate drive letter in the command line, in place of [drive]).

4. Depending on which operating system you are installing the Visionary Editor software on,
the “Open File - Security Warning” dialog box may appear.  If this dialog box appears, click
the Run button.
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5. The “Preparing to Install...” window will appear momentarily to indicate the status of the
software’s installation.

6. The “Welcome to the InstallShield Wizard for Trilithic Visionary Editor” window will appear.
Click the Next button to continue with the installation.
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7. The “License Agreement” window will appear.  To continue with the installation, select the
radio button which corresponds with acceptance of the license agreement, then click the
Next button.

8. The “Customer Information” window will appear.  Enter the User Name and Organization
name which correspond to the individual who will use the software.  Click the Next button
continue; click the Back button to return to the “License Agreement” window.
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9. The “Destination Folder” window will appear.  The default location in which the Visionary
Editor software will be installed is displayed.  To install the software in a file location other
than the default, click the Change button and select a different directory; otherwise click
Next to accept the default directory in which to install the Visionary Editor software.

10.The “Ready to Install the Program” window will appear next.  This window confirms the
settings for the Visionary Editor installation.  If the information shown is correct, click the
Next button.  To change the installation settings, click the Back button.
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11. The “Installing Trilithic Visionary Editor” window will momentarily appear to indicate the
status of the software’s installation.

12.The “InstallShield Wizard Completed” window will appear.  Click the Finish button to exit
from the installer.  The Visionary Editor installation is now complete.
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Software Updates

To update the Visionary Editor software, the new version of the software can be installed over the
existing version.  Follow the procedure outlined in Chapter 3: Installation, Installing the
Visionary Editor Software to install the updated version of the software.

Removing the Visionary Editor Software

The Windows Add or Remove Programs utility can be used to remove the Visionary Editor
software.

1. Open the Add or Remove Programs utility be clicking the Windows Start button, then the
Control Panel program group.

2. From the control panel, click the Add or Remove Programs icon.  A program list similar
to the one shown below will be displayed:
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3. In the program list, scroll to find Trilithic Visionary Editor.

4. To remove the program, select the program by clicking on it once, then click the Remove
button.

5. A pop-up window will appear, confirming your decision to remove the Visionary Editor
program.  Click the Yes button to remove the Visionary Editor program; click the No button
to cancel the program deletion.
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4. Configuration
Chapter 4

Overview

The Visionary Editor program can communicate with as many as 1000 Visionarys, or it can be
configured to communicate with a single Visionary.  Before custom messages and graphics can
be sent to the Visionary and ultimately to the subscribers, communication information, screen
resolution, and safe title area should be configured for all Visionarys.

13 14

Configuring a Visionary

For a Visionary to work in conjunction with the Visionary Editor program, the program must be
configured to communicate with the Visionary.  To configure a Visionary, click the File menu, then
click the Setup option.
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In the pop-up window, enter the following configuration parameters:

1. (Select) Name - Select a Visionary to be edited, if multiple configurations exist.

2. (Edit) Name - Enter a name for the remote Visionary, which should be easily recognizable
and intuitively associated with the particular Visionary.

3. IP Address - Enter the IP address of the Visionary.
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4. TCP Port - Enter the TCP port number that the Visionary has been configured to monitor
for commands.  The default value is 59901.

5. Add - After entering the Name, IP Address, and TCP Port, click the Add button to add the
Visionary and continue with the Visionary configuration.

6. Delete - Click the Delete button to delete the selected Visionary.  If the Visionary Editor
program is configured to communicate with Visionarys, select the Visionary to be deleted
in box 1.

7. Show (Safe Title) - Select this check box to toggle the safe title border on or off.

8. (Safe Title) Percent - Use this control to set the percentage of the screen that is included
within the safe title area.  The size (as a percentage of the screen) can be selected from
the Percent pull-down list, or a custom number can be entered in the Percent text box.

9. (Safe Title) Color - Click the Color box to open the Color window and select a different
color for the safe title border on the screen.

10. (Safe Title) Transparency - This setting indicates the transparency of the safe title border.
The percentage of transparency can be selected from the Transparency pull-down list, or
a custom number can be entered in the Transparency text box.

11. (Safe Title) Line Size - Use this pull-down list to set the thickness of the safe title border.
The line size, in pixels, can be selected from the Line Size pull-down list, or a custom
number can be entered in the Line Size text box.

12.Screen Size - Use this pull-down list to select the resolution of the program stream that the
page will appear on (high-definition or low-definition).

13.Accept - Click the Accept button to save the Visionary configuration parameters that have
been entered.

14.Cancel - Click the Cancel button to abort the Visionary configuration procedure.

After all configuration parameters have been entered, click the Accept button to add the Visionary
configuration.  To abort the Visionary configuration procedure, click the Cancel button.
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Configuring Multiple Visionarys

The Visionary Editor software can interface with as many as 1000 remotely-installed Visionarys.
To add a new device to the list of configured Visionarys, click the File menu, then click the Setup
option.  In the pop-up Editor Setup window, Click the Add button.  A new Visionary will be added,
and the text within the Name text box will be updated to indicate the new Visionary.  Enter the
configuration parameters for the new Visionary as described in Chapter 4: Configuration,
Configuring a Visionary.  In the Name text box, enter a different name for the new Visionary than
previously-entered names.

After all configuration parameters have been entered, click the Accept button to add the new
Visionary to the list of devices that the Visionary Editor program communicates with.  Click the
Cancel button to abort the Visionary addition procedure.

Deleting a Configured Visionary

To delete a Visionary from the list of configured devices within the Visionary Editor program, click
the File menu, then click the Setup option.  In the pop-up Editor Setup window, select the named
Visionary to be deleted, then click the Delete button.  Click the Accept button or the Cancel
button to close the Editor Setup window.

Editing a Visionary’s Configuration

To edit the configuration parameters for a Visionary, click the File menu, then click the Setup
option.  In the pop-up Editor Setup window, select the named Visionary whose configuration will
be edited (if more than one Visionary is configured).  Edit the configuration parameters for the
new Visionary as described in Chapter 4: Configuration, Configuring a Visionary.
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5. Using the Program
Chapter 5

Overview

The Visionary Editor program is an intuitive application that allows operators to quickly and easily
design, edit, and distribute custom video overlay pages to multiple Visionary devices.  The
following instructions provide detailed instructions in creating, saving, and uploading Visionary
video pages.

Creating a Custom Page
The Visionary Editor software allows you to create, save, and upload video overlay pages.  This is
especially useful for recurring messages where a pre-saved graphic overlay page can be loaded
and distributed with little or no editing.  These pages are stored by the Visionary Editor program
for later reference and repeated use.
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Creating a New Page File

If a file is currently open and you would like to create a new page file, click the File menu, then
click the New menu option.  This procedure will clear the Visionary Editor screen of all objects.

Opening an Existing  Page File

Page files that have been previously created and saved can be opened for editing.  To open
an existing page file, click the File menu, then click the Open menu option.  The file is
displayed in the Visionary Editor window.

Saving a Page File

A page file can be saved for editing at a later time, or to be loaded to the Visionary and
displayed to viewers.  To save the current screen as a page file, click the File menu, then click
the Save option.  The Save As dialog box will open; select a location and save the page file.
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1. Fade In - This is the time, in seconds, in which the video overlay page will “fade in” from
transparent to opaque.

2. Fade Out - This is the time, in seconds, in which the video overlay page will “fade out” from
opaque to transparent.

3. (Page) Repeats - Enter the number of times the entire video overlay page will be
repeated, including repeated text crawls and repeated audio messages.  As an alternate
means to enter the number of times the audio file is repeated, left-click in the (Page)
Repeats text box and while holding the mouse button, drag the mouse from left to right to
set the number of times the page is repeated.

4. (Page) Delay- Enter the number of seconds to wait before repeating the entire page.  The
delay starts when the previous page has been removed.  As an alternate means to enter
the audio delay, left-click in the (Page) Delay text box and while holding the mouse button,
drag the mouse from left to right to set the page delay time.

Editing Page Attributes

The individual properties for a page within the Visionary Editor program can be edited and
customized.
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5. (Audio) Filename - This is the file name of the selected audio message.  To select an
audio file, click within the (Audio) Filename text box, then select an audio file.  The audio
file must be in WAV format.

6. (Audio) Repeats - Enter the number of times that the audio message will be repeated.  As
an alternate means to enter the number of times the audio file is repeated, left-click in the
Repeats text box and while holding the mouse button, drag the mouse from left to right to
set the number of times the audio file is repeated.

7. (Audio) Pause - Enter a number in the (Audio) Pause text box to set the delay time
between repeated audio messages.  As an alternate means to enter the delay time
between repeated playing of the audio file, left-click in the Pause text box and while
holding the mouse button, drag the mouse from left to right to set the audio pause time.

8. (Audio) Delay - This is the time, in seconds, that the audio message will be delayed when
the page is displayed.  This feature is typically used to time an audio message to coincide
with a text crawl.  As an alternate means to enter the audio message delay time, left-click in
the (Audio) Delay text box and while holding the mouse button, drag the mouse from left to
right to set the audio message delay time.

9. Color - Click the Color box to open the Color window and select a different color for the
canvas (background).  The canvas color is shown only on the Visionary Editor program’s
screen and not displayed on the video stream when the video overlay page is uploaded to
the Visionary.

To change the transparency of the canvas color, left-click in the Color box and while
holding the mouse button, drag the mouse from left to right to set the canvas transparency.

10. Image File- This is the file used as a background image for the canvas.  To select an
image file, click the Filename text box, then select the image file to be used as the
canvas’s background.  The background image is shown only on the Visionary Editor
program’s screen and not displayed on the video stream when the video overlay page is
uploaded to the Visionary.

11. Layout - This control box determines the display properties for the background image.
Selecting Corner from the pull-down list will push the background image to the top-left
corner of the canvas; selecting Center will place the image in the center of the canvas;
selecting Stretch will scale the background image to fit the entire canvas.
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Creating Screen Objects

The Visionary allows an operator to create custom messages which can be overlaid on the video
stream.  The operator can create static text, crawl text, logo, and graphic overlays.

Images

To add an image, click the Images menu, then click the Add Image option to place an image
on the screen.  From the Open file dialog box, browse to the location where the image to be
inserted is stored, then select the image.  Click the Open button to place the image; click the
Cancel button to abort the image placement operation.  By default, the image is placed at the
top-left corner of the screen.

BMP, JPG, PNG, and TIF formatted image files are supported by
the Visionary.

Each of the methods for placing screen objects will be discussed
individually in the following sections.  As an alternate means to
place screen objects, right-click on the canvas and select the
desired menu option from the pop-up menu.  The screen object
will be placed with the top-left corner of the object at the same
point where the initial click was made on the canvas.

As an alternate means to place images, right-click on the canvas
and select the Add Image menu option from the pop-up menu.
The image will be placed with the top-left corner of the image at
the same point where the initial click was made on the canvas.
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Editing handle

Selected image

Editing handle

After an image has been placed, the properties of the image can be edited using the control
panel at the right side of the screen.  The image must be selected by single-clicking on it
before the Image Effects and Image Attributes control panels are available.  Selecting an
image on the canvas will display a small circle (handle) at the top-left and bottom-right corner
of the image to indicate the selection.  The image can be scaled by clicking and dragging
either of these “handles.”

The size of the image is referenced in points.  As a reference, an
image with pixel dimensions of 486 (h) x 720 (w) will appear as a
full-screen image in low-definition; an image with pixel
dimensions of 486 (h) x 852 (w) will appear as a full-screen
image in high-definition.
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Below is a description of each setting within the control panel:

1. Fade In - This is the time, in seconds, in which the image will “fade in” from transparent
to opaque.

2. Fade Out - This is the time, in seconds, in which the image will “fade out” from opaque
to transparent.

3. File Name - This is the file name of the selected image.  With an image selected, click
the Filename text box to browse for a new image.  When the Open button is clicked in
the Open dialog window, the new image will replace the selected image on the canvas.

4. Location - This the (X,Y) location, in points, of the selected image.  The top-left corner
of the image is referenced by the location coordinates.

5. Alpha - This setting indicates the transparency of the selected image.  The percentage
of transparency can be selected from the Alpha pull-down list, or a custom number can
be entered in the Alpha text box.  As an alternate means to enter the alpha
(transparency), left-click in the Alpha text box and while holding the mouse button, drag
the mouse from left to right to set the image transparency.

6. (Size) Stretch - This is the size of the selected image.  The first text box indicates the
width (as a percentage of the original image width); the second text box indicates the
height (as a percentage of the original image height).  As an alternate means to enter
the size of the image, left-click in either of the (Size) Stretch text boxes and while
holding the mouse button, drag the mouse from left to right to set the size of the image.
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7. Lock Aspect Ratio - Select this box to constrain the height and width of the image so
the image is scaled proportionately.  Selecting this check box also constrains the
proportions of the image as it is scaled with the mouse, via click and drag.

8. Rotation Angle - This control box allows the selected image to be rotated.  The
degrees of rotation (in a clockwise direction) can be selected from the Rotation pull-
down list, or a custom number can be entered in the Rotation text box.  As an alternate
means to rotation angle of an image, left-click in the Angle text box and while holding
the mouse button, drag the mouse from left to right to set the rotation angle.

Images can be edited via click and drag, in addition to editing with the control panel.  The
following operations can be performed via click and drag, after the image has been selected:

• Move - Left-lick on the image then drag it to a new location.  The location (X,Y) of the
image will update in the control panel after the image has been moved.

• Resize - Left-lick on the “handle” at the top-left corner or bottom-right corner of the
image then drag the handle to resize the image.  The size (width, height) of the image
will update in the control panel after the image has been resized.

• Rotate - Hold the Shift key and left-click on the image and drag to rotate the image.
The rotation angle (in degrees) of the image will update in the control panel after the
image has been rotated.

• Transparency - Right-click on the image and drag the mouse up or down to change
the transparency of the image.

Editing handles are
available when

image is selected

Left-click and drag
to move image

Hold Shift key, left-
click and drag to

rotate image

Right-click and drag to
change image
transparency

Left-click and drag either
editing handle to resize
image
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A maximum of 2 crawl text strings can be placed on the canvas
at the same time.

As an alternate means to place text, right-click on the canvas and
select the Add Static Text or Add Crawl Text menu option from
the pop-up menu.  The text will be placed with the top-left corner
of the text string at the same point where the initial click was
made on the canvas.

Text

To add text, click the Text menu, then click either the Add Static Text option or the Add Crawl
Text option.  By default, the text is placed in the top-left corner of the screen.  Static text can be
moved to any location on the screen by clicking on the text and dragging it to the new location.
Crawl text can only be moved on the vertical plane of the screen by clicking on the text and
dragging it to the new location.
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Editing handle

Selected static
text

Editing handle

Text edit panel

Once a static text string has been placed on the canvas, it can be edited.  To edit the text
string, select  by left-clicking on the text string.  Edit “handles” will appear at the top-left corner
and bottom-right corner of the text string, and the selected text will appear in the edit window at
the bottom of the Visionary Editor screen.  Static text can also be edited by double-clicking on
the text string then edit the text directly on the canvas.  The static text string can be edited in the
edit window at the bottom of the screen.  When finished editing the static text string, left-click
on any open area on the canvas to deselect the static text string.
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Editing handle

Selected crawl
text

Text edit panel

A crawl text string can be edited similarly to the static text string.  Select the crawl text string by
left-clicking on the crawl text string.  An edit “handle” will appear at the top-left corner of the
crawl text string, and the selected text will appear in the edit window at the bottom of the
Visionary Editor screen.  The crawl text string can only be edited in the window at the bottom of
the screen.  When finished editing the crawl text string, left-click on any open area on the
canvas to deselect the crawl text string.
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After the text has been placed and edited, the properties of the text can be edited using the
control panel at the right side of the Visionary Editor screen.  The text must be selected by
single-clicking on it before the Text Effects, Text Attributes, Crawl Effects, or Crawl Text
control panels are available.  Selecting a static text string on the canvas will display a small
circle (handle) at the top-left corner and bottom-right corner of the text string to indicate the
selection.  Selecting a crawl text string on the canvas will display a small circle (handle) at the
top-left corner of the text string to indicate the selection.  Following is a description of each
setting within the control panels:
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When a static text string is selected, the left-side control panel
will appear in the Visionary Editor window.  When a crawl text
string is selected, the right-side control panel will appear with
four additional options which control the crawl text animation.

1. Fade In - This is the time, in seconds, in which the text will “fade in” from transparent to
opaque.

2. Fade Out - This is the time, in seconds, in which the text will “fade out” from opaque to
transparent.

3. Font - This is the font name for the selected text.  Click the Font pull-down list to select
a different font for the selected text string.  To select additional fonts which are not
included in the Font list, select the ...Configure Fonts... option from the pull-down list.
Refer to Chapter 5: Using the Program, Creating Screen Objects, Text, Font
Configuration for additional instruction in adding fonts to the Font list.

4. (Font) Size - This is the size, in points, of the selected text.  Click the Font Size pull-
down list to select a different font size for the text string.  As an alternate means to set
the font size, left-click in the (Font) Size text box and while holding the mouse button,
drag the mouse from left to right to set the font size.

5. (Font) Style - Click B to apply a bold-face type style to the selected text; click I to apply
an italic-face type style to the selected text.  The B and I buttons will display an orange
highlight state when the selected text has had bold or italics type styles applied.

6. (Font) Color - Click the (Font) Color box to open the Color window and select a
different text color.

To change the transparency of the text, left-click in the (Font) Color box and while
holding the mouse button, drag the mouse from left to right to set the text transparency.

7. (Font) Location - This the (X,Y) location, in points, of the selected text.  The top-left
corner of the text string is referenced by the location coordinates.  As an alternate
means to set the location of the text string, left-click in either of the (Font) Location text
boxes and while holding the mouse button, drag the mouse from left to right to set the
location of the text string.

8. (Background) Color - Click the Background Color box to open the Color window
and select a different color to appear behind the text.

To change the transparency of the background, left-click in the (Background) Color
box and while holding the mouse button, drag the mouse from left to right to set the
transparency of the background color.
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9. (Background) Layout - Use this pull-down list to select whether or not there will be a
background behind the text.  Select the Rectangle option to cause a colored
background to appear behind the text; select the None option to cause the text to
directly overlay on the screen.

10. (Outline) Color - Click the Outline Color box to open the Color window and select a
color with which to outline each character in the selected text string.

To change the transparency of the text outline color, left-click in the (Outline) Color
box and while holding the mouse button, drag the mouse from left to right to set the
transparency of the text background.

11. (Outline) Size - Use the Outline Size pull-down list to select the thickness of the
outline around each character in the text string.  For no outline, set the value to 0.  As an
alternate means to set the outline size, left-click in the (Outline) Size text box and while
holding the mouse button, drag the mouse from left to right to set the outline size.

12. (Shadow) Offset - Enter a number in the (Shadow) Offset text box to set the distance
of the shadow from the text string.  For no shadow, set the value to 0.   As an alternate
means to set the shadow offset, left-click in the (Shadow) Offset text box and while
holding the mouse button, drag the mouse from left to right to set the shadow offset.

13. (Crawl) Speed - Enter a number in the (Crawl) Speed text box to set the speed at
which the text crawls across the screen.  The value is measured in 30 pixels per second
(PPS x 30).   As an alternate means to set the crawl speed, left-click in the (Crawl)
Speed text box and while holding the mouse button, drag the mouse from left to right to
set the crawl speed.

14. (Crawl) Repeats - Enter the number of times that the crawl text will be displayed.   As
an alternate means to set the number of crawl repeats, left-click in the (Crawl) Repeats
text box and while holding the mouse button, drag the mouse from left to right to set the
number of crawl repeats.

15. (Crawl) Pause - Enter a number in the (Crawl) Pause text box to set the delay time
between repeated crawls.   As an alternate means to set the crawl pause, left-click in
the (Crawl) Pause text box and while holding the mouse button, drag the mouse from
left to right to set the number of seconds for the crawl pause.

16.Crawl Delay - This is the delay, in seconds, between when the page is first displayed
and when the text begins to crawl.

Static and crawl text can be edited via click and drag, in addition to editing with the control
panel.  The following operations can be performed via click and drag, after the text has been
selected:

• Move - Click on the text string then drag it to a new location.  The location (X,Y) of the
text will update in the control panel after the text has been moved.  Static text can be
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moved to any location on the screen; crawl text can only be moved vertically on the
screen.

• Resize - Click on the “handle” at the top-left corner or bottom-right corner of the static
text string then drag the handle to resize the text.  The size (in points) of the text will
update in the control panel after the text string has been resized.  Static text can be
resized via click and drag; crawl text can only be resized in the control panel.

• Background Transparency - Right-click on the text string and drag the mouse up or
down to change the transparency of the text background.

Editing handles are
available when text

string is selected

Left-click and drag
to move text string

Right-click and drag
to change

background
transparency

Left-click and drag
editing handle to
resize text string

Font Configuration

By default, the Visionary Editor program is configured with three fonts for static and crawl
text.  Additional fonts can be added to the Visionary Editor program’s font list, however the
font files must also be added to the Visionary’s internal memory.  Refer to the Font
Configuration section in the Visionary Hardware Installation and Configuration
manual for instructions in uploading font tiles to the Visionary.

Following is the process to configure the Visionary Editor program to recognize and
display additional fonts:

1. Select a text string on the Visionary Editor’s canvas to display the Text Attributes
control panel.

2. From the Font pull-down list, select the ...Configure Fonts... menu option.  The
Font Configuration window will be displayed.
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In the All Fonts (left side) column, all fonts that are installed on the Visionary Editor
program’s host computer are displayed. In the Fonts (right side) column, all fonts
that are configured in the Visionary Editor program are displayed.

3. To add a font to the Visionary Editor’s configuration, select the font in the All Fonts
(left side) column by left-clicking on the font name.  Click the  button between the
columns to copy the font to the Fonts (right side) column.

4. To remove a font from the Visionary Editor’s configuration, select the font in the
Fonts (right side) column by left-clicking on the font name.  Click the  button
between the columns to remove the font from the Fonts column.

4. Click the OK button to load the font configuration changes to the Visionary Editor
program; click the Cancel button to abort the font configuration.

Fonts used in the Visionary Editor program must be loaded to
the Visionary.  Refer to the Visionary Hardware Installation and
Configuration manual for instructions in uploading fonts to the
Visionary.
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Boxes

To add a box, click the Shapes menu, then click the Add Box option to place a square or
rectangular box on the screen.  A temporary message will appear on the screen with the text,
Left Click to Start Drawing Box.  Click the mouse where the top-left corner of the box should
be placed.  Click and drag with the left mouse button to draw the box.  The initial click location
on the screen will be the top-left corner of the box; drag the pointer down and to the right to
define the shape of the box.  Release the mouse button to place the box on the screen.

Temporary
message

containing
instructions to

draw box

As an alternate means to place boxes, right-click on the canvas
and select the Add Box menu option from the pop-up menu.
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1
2

After the box has been placed, the properties of the box can be edited using the control panel
at the right side of the screen.  The box must be selected by single-clicking on it before the
Shape Effects, and Shape Attributes control panels are available.  Following is a
description of each setting within the control panels:

Left-click to
begin drawing

box

Editing handles
are available

when image is
selected

3

4

7

6

5

Drag to draw
box
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1. Fade In - This is the time, in seconds, in which the box will “fade in” from transparent to
opaque.

2. Fade Out - This is the time, in seconds, in which the box will “fade out” from opaque to
transparent.

3. Select With - Select the Outline option from the pull-down list to display the box only as
an “outlined” shape; select the Whole option to display the box as a “filled” shape.

4. Location - This the (X,Y) location, in points, of the selected box.  The top-left corner of
the box is referenced by the location coordinates.

5. Color - Click the Color box to open the Color window and select a different text color
for the box.

To change the transparency of the box, left-click in the Color box and while holding the
mouse button, drag the mouse from left to right to set the transparency of the box.

6. (Outline) Color - Click the (Outline) Color box to open the Color window and select a
color with which to outline the selected box.

To change the transparency of the box outline, left-click in the (Outline) Color box and
while holding the mouse button, drag the mouse from left to right to set the transparency
of the box outline.

7. (Outline) Size - Use the (Outline) Size pull-down list to select the thickness, in pixels,
of the outline around the box.  For no outline, set the value to 0.

Boxes can be edited via click and drag, in addition to editing with the control panel.  The
following operations can be performed via click and drag, after the box has been selected:

• Move - Click on the box then drag it to a new location.  The location (X,Y) of the box will
update in the control panel after the box has been moved.

• Resize - Click on any one of the “handles” at any of the corners of the box then drag the
handle to resize the box.  The size (width, height) of the box will update in the control
panel after the box has been resized.

• Transparency - Right-click on the box and drag the mouse up or down to change the
transparency of the box.
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Left-click and drag
to move image

Right-click and drag to
change image
transparency

Editing Screen Objects

Once images, text, or boxes have been placed on the screen, the individual properties for each
object can be edited.  Each object type can be edited via click and drag after the object is
selected, or via the control panel at the right side of the screen.  For detailed instructions in editing
an object, refer to Chapter 5: Software Operation, Creating Screen Objects, Images, or Text,
or Boxes.

Screen objects may also be edited through the cut, copy, and paste commands.  The cut, copy,
and paste commands are available through the Edit menu in the Visionary Editor program.

Left-click and drag any
editing handle to resize
box
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A description of each of the commands and their respective shortcut keys follows.  After the
screen object is selected, any of the following commands may be used.

Command Description Shortcut

Cut Removes the selected screen object from the canvas Ctrl + X
and copies the screen object to the clipboard

Copy Copies the selected screen object to the clipboard Ctrl + C
without removing the screen object from the canvas

Paste Selected Duplicates a selected screen object on the canvas Ctrl + V

Paste Copy Places the object from the clipboard (that was previously n/a
cut or copied) to the same location as where the original
screen object had been cut/copied

Delete Removes a selected screen object from the canvas Ctrl + D
without copying the screen object to the clipboard

Select All Selects all screen objects on the canvas Ctrl + Shift + A

Multiple screen objects can be selected by holding the Shift key
while clicking on multiple objects.
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Changing the Layer Order of Objects

As multiple screen objects (static and crawl text, images, and boxes) are placed on the screen in
the Visionary Editor program, they are placed in a layered order.  The first screen object placed is
on the bottom layer, with successive objects being placed on top of the first object.  The layer
order of screen objects can be changed to alter the appearance of screen objects.  To change the
layer order of an object, the object first must be selected by clicking on it once.  Click the Modify
menu, then click the Arrange menu option to display the layer options.

Changing the Screen Resolution

The Visionary Editor program’s screen aspect ratio must be changed to match the aspect ratio of
the video stream.  To change the Visionary Editor program’s screen aspect ratio, click the View
menu, then select the High Def menu option for a 16:9 aspect ratio, or the Low Def menu option
for a 4:3 aspect ratio.
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A description of each of the commands and their respective shortcut keys follows.  After the
screen object is selected, any of the following commands may be used.

Command Description Shortcut

Bring to Front Moves a screen object to the front of the layering order, Ctrl + Shift + 
causing it to display on top of all other screen objects

Move Forward Moves a screen object forward in the layering order Ctrl + 
by one layer position

Move Backward Moves a screen object backward in the layering order Ctrl + 
by one layer position

Send to Back Moves a screen object to the back of the layering order, Ctrl + Shift + 
causing it to display behind all other screen objects

“Top” screen
object

“Bottom”
screen object

Refer to the following example for an illustration of changing the layering order of screen objects:

1. Select the photograph by clicking on it once.  When the photograph is selected, the blue
“handle” on the top-left corner of the box will be displayed (the red “handle” at the bottom-
right corner of the photograph is hidden “below” the orange rectangle).

2. Click the Modify menu; click the Arrange menu option; then click the Bring to Front menu
choice.  The selected photograph will be moved to the front of the layering order, as shown
in the following illustration.
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“Bottom”
screen object

“Top” screen
object

Uploading Pages to the Visionary

After a graphic overlay page has been created, it must be uploaded to the Visionary(s) in order to
be displayed.  To send the graphic overlay page to the Visionary, click the Visionary menu, then
click the Send menu option.  The page will be sent to the selected Visionary.  To update an
existing page that has already been sent to the Visionary, click the Update menu option.  Before a
graphic overlay page can be sent, the Visionary which will receive the page must be selected from
the pull-down list at the bottom of the Visionary Editor program window (shown below).

Alternately, the graphic overlay page can be sent to the Visionary by first selecting the target
Visionary from the pull-down list at the bottom of the Visionary Editor window, then clicking the
Send button.  Once the graphic overlay page has been sent to the Visionary, it can be updated by
clicking the Update button.
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If the displayed page contains transient objects (audio files or crawl text), the display of the
graphic overlay page will cease to display after the crawl text and audio file are complete.  If all
screen objects are static, the graphic overlay page will continue to be  displayed indefinitely, or
until the Update button is clicked to clear the graphic overlay page from the Visionary.  The
update command will remove the current graphic overlay page from display.  If a graphic overlay
page is waiting in queue, it will be displayed after the Update button is clicked.

The Send button will upload the graphic overlay page to the
Visionary.  If no pages are waiting in queue, the page will be
displayed immediately.  If there are graphic overlay pages in
queue, the page will be added to the end of the queue.

Additional File Commands

Export to Image

The Visionary Editor program allows screen objects (images, boxes, and text) to be exported
as an image file.  To export a screen object, select the object on the screen; click the File
menu; click the Export Selected to Image; then select a file location and name for the
exported file.

To export multiple screen objects as a single image file, hold the Shift key while clicking on
multiple screen objects, then click the File menu; click the Export Selected to Image; then
select a file location and name for the exported file.

EAS alerts are received by the Visionary with a higher priority
than graphic overlay pages received from the Visionary Editor
program, and will be displayed before graphic overlay pages.  If
an EAS alert is received by the Visionary while a graphic overlay
page is being displayed, the EAS alert will overwrite the
currently-displayed page.
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